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Kit overview (1/3) heen
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Kit overview (2/3)

» Color LED card

— Showcases color control

Low power RGB LEDs
(10 mA per channel)
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Kit overview (3/3)

)

White LED card

— Showcases brightness control

White LED strings (5 LEDs per string)
24 V powered, 20 mA per channel

Temperature
sensor

Ambient light
sensor

DALI connectivity

Copyright © Infineon Technologies AG 2016. All rights reserved.

(infineon

RF
connectivity



afineon

>
Q
0,
-
Q
Q

Kit overview

Hardware overview

Tooling overview — boot modes
Tooling overview — DAVE™
Getting started - examples
General information

References

Copyright © Infineon Technologies AG 2016. All rights reserved.



Infineon

i

Hardware overview

» Attach color LED or white LED card to XMC1200 CPU card
» Connect XMC1200 CPU card to PC via USB cable
» CPU card is powered up (as indicated by LED on the card)

CPU card powered —
via USB cable R - -

EENERED BEERRER BEREER
LT LT L T T LT T T I T

mnnm

3 : . Cinfieon |

P8 |0 © pag
P vooe'

Copyright © Infineon Technologies AG 2016. All rights reserved.



afineon

>
Q
0,
-
Q
Q

Kit overview

Hardware overview

Tooling overview — boot modes
Tooling overview — DAVE™
Getting started - examples
General information

References

Copyright © Infineon Technologies AG 2016. All rights reserved.



Tooling overview (infineon
Boot modes

» Boot modes available

— UART bootstrap-loader mode

- User mode (Halt after reset)

— User mode (Debug) Default mode of device on boot kit
— User mode (Productive)

» Boot modes can be configured via:

- DAVE™
— Download DAVE™

http://www.infineon.com/dave/v4
- MemTool

— Download MemTool

http://www.infineon.com/cms/en/product/channel.html?channel=ff80808112ab681d011
2ab6b50fe07c9

> For more information on how to configure the BMI value, please refer to the
XMC1000 tooling guide

Copyright © Infineon Technologies AG 2016. All rights reserved.
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Tooling overview (infineon
DAVE™

» DAVE™ is a free development platform for code generation by
Infineon

» It can be downloaded from:

— http://www.infineon.com/dave/v4

» For a guide on setting up DAVE™, please refer to XMC1x00 boot
kit getting started

Copyright © Infineon Technologies AG 2016. All rights reserved.
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Getting started - Example 1
RGB lamp using LED_LAMP APP (1/20)

Example 1: RGB lamp using LED_LAMP APP

Connect to PC

XMC1200/XMC1300
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Getting started — Example 1 (ﬁﬁneon
RGB lamp using LED_LAMP APP (2/20)

1. Open DAVE™ r 3. Select the device accordingly

DAVE-41.2 .
& New DAVE Project CR X

Microcontroller Selection Page

Select the microcontroller for which the project has to be created

2. In DAVE™ workspace, create :
a new "DAVE™ CE"” project: B o

» 7] ¥MC1100 Series
4[] XMC1200 Series

. . [¥] XMC1200-T038:0200 _
> File->New->DAVE™ Project 5 e Qo
D KMC1202-TD28:0064
D KMC1202-TD28:0032

» Give the project a name e.qg. = iz rasons '
“"RGB_LAMP_EXAMPLE" _—

m

-
% New DAVE Project = x| Egu: fg?{gﬂ:;h 3
DAVE Project InOut= 34 digital 'O

ADC=12 ADC Channels, 12-bit, Analeg-to-Digital Converter

S I t A\ DAV ETM C E Create a new C/C++ project for Infineon tool chains
Project Name:  RGBLamp_Example0l Linker Option

P ro - ect n a S ro . ect Use defaut location [/] Rernove unused sections
|
J p J C:/Workspaces/DAVE-4.1.2/XMC_LED_Current Control Explorer W/ | Erowse.

Runtime Library
t Project Type: Tool Chain: Library Newlib-nano -
e 4 (= Infineon Projects [ARM-GCC Application |
a (& ARM-GCC Application I:‘ Add floating point support for printf

[ Easy Start Project ) .

[Z Simple Main Project || Add floating point support for scanf
[ DAVE CE Project
[Z] Empty Project

a (& ARM-GCC Library
[Z] Empty Project

@ < Back Next » Enish | [ Cancel

Show project types and toal chains only if they are supported on the platform

@ < Bac Next Finish Cancel

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (in’f?neon,
RGB lamp using LED_LAMP APP (3/20)

»  This example demonstrates RGB lamp functionality using LED_LAMP APP
»  We will use the system timer (SysTick) as the time base for the interrupt

— Time base of 1 s

- In the interrupt, a new target dimming level or target color is regularly
set with a 7 s transition time

> Next, we will show you the steps to creating this project:

Instantiate LED_LAMP APP

Configure LED_LAMP APP

Configure BCCU Channels

Assign PDM_BCCU APPs to the right channels

Configure Brightness and Color Control Unit (BCCU) global settings
Configure Port Pins

Configure SysTick

Define the SYSTIMER callback function

N LA WNH



Getting started — Example 1 (iﬁﬁneon,
RGB lamp using LED_LAMP APP (4/20)

1. Instantiate LED_LAMP APP =
> Click 4, to add new APP
» Select the LED_LAMP APP

» LED_LAMP APP automatically
aggregates a BCCU channel app
(PDM_BCCU), a BCCU dimming
engine app (DIM_BCCU) and a
BCCU global app

(GLOBAL_BCCU) e

EE

wm APP Dependency B2 g HW Signal Connectivity

LED_LAMP
LED_LAMP_0
gl —y y
PDM_BCCU DIM_BCCU
PDM_BCCU_0 DIM_BCCU_0

a Y
GLOBAL_BCCU
GLOBAL_BCCU_0

T

CLOCK_XMC1
CLOCK_XMC1_0

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (ﬁ{ﬁneon
RGB lamp using LED_LAMP APP (5/20)

2. Configure LED_LAMP APP 4 APP Dependency 52 | ua HW Signal Connectivity

LED LAKP
» Double-click LED_LAMP_O to —
Open UI T F-'ZI‘_E;CELI - .- :II‘_E!EIELI
n‘ PDM_BCCU_0 ‘ DIM_BCCU_0 ‘

|
L

".'n I. L__
GLOBAL_BCCU
GLOBAL_BCCU_0

|
— set Number of LED ‘ CLOCK XHCT ‘

CLOCK_XMC1_0
channels to 3

» Under General Settings tab,

LED_LAMPO 53

— select Dimming Engine as
Dimming Source

General Settings | Dimming and Intensities Settings

Settings
| Enable LED_LAMP at initialization

LED driver

control method: | Direct PDM (External LED Drivers) -
Mumber of LED | 5 _ D
channels:

Dimming source:| Dimming Engine {u—— -

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1
RGB lamp using LED_LAMP APP (6/20)

2. Configure LED_LAMP APP
(continued)

LED_LAMP_0 53

» Under Dimming and o
mg = - General Settings | Dimming and Intensities Settings
IntenS|t|es Settl ngs ta b Initial Dimming and Intensity Levels

Dirnming Level b Intensity
- set initial Dimming Level e il = e
to 1024 LED channel 2: | 1024 5 b 1365 | B3.2
- set initial Channel o] (5 s - (10510
Intensities to 1365 = B %o (1R
- set initial Intensity linear 4] [ | x a5 [0
walk time to 0 ms - o
— Set initial 0_1000/0 InitiaIlFadleRates | _—
dimming transition time T L wes
to 0 ms 0-100% dimming transition time [ms]: | 0.0 (DLCK_PS): 1]

(infineon.

Brightness
341
341
341
1024 5
1024 5
1024 5
1024 5
1024 5
1024 5

%D Etlﬁrrl\j;w: 0



Getting started — Example 1 (iﬁﬁneon,
RGB lamp using LED_LAMP APP (7/20)

2. Configure LED_LAMP APP (continued)
» Rename Instance Label

- Right-click LED_LAMP APP
— Select Rename Instance Label...
- Rename as RGB_LAMP

i Instance Label I,&J

Please Specify Instance Label: RGE_LAMP

QK l | Cancel

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (ﬁ,’ffneon
RGB lamp using LED_LAMP APP (8/20)

3 \ CO n fi g u re BCC U C h a n n e I S 4a APP Dependency 57 | 4 HW Signal Connectivity =) Console [ Properties [*] Problems

LED_LAMP
LED_LAMP_0
- ‘ o
» Double-click a PDM_BCCU (-
—
A P P PDM_BCCU PDM_BCCU PDM_BCCU DIM_BCCU
PDM_BCCU_1 PDM_BCCU_2 PDM_BCCU_O DIM_BCCU_0

LLLLLLLLLLLLL

CLOCK_XMC1
CLOCK_XMC1_0

» Select Flicker Watchdog
(WD) to enable

PDM_BCCU0 53

Channel Settings | Pin Settings

[ [Enable channel at inftialization| | actual linear walk time [msec]: 0.0

Linear prescaler [dec]:

|| Bypass dimming input |

Target
intensity

4095

Flicker WD

>  Repeat for the other 2 oirming
PDM_ BCCU APP instances

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (ﬁ{ﬁneon
RGB lamp using LED_LAMP APP (9/20)

4. Assign PDM_BCCU APPs to the right channels

» Hover mouse cursor over the connecting arrow to a PDM_BCCU
APP

> A label will appear momentarily e.g. LEDO/LED1/LED2

as APP Dependency $2 | 4o HW Signal Connectivity Console [| Properties |*  Problems & Prog

LED_LAMP_0

K [% . .
PDM BCCU PDM_BCCU . CCU DIM_BCCU
PDM_BCCU_1 PDM_BCCU_2 PDM_BCCU_0 DIM_BCCU_0

GLOBAL_BCCU_0

CLOCK_XMC1_0

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (ﬁ,’ﬁneon
RGB lamp using LED_LAMP APP (10/20)

4. Assign PDM_BCCU APPs to the right channels (continued)

» The labels correspond to the LED channels in the UI
f&] LED_LAMP O &3

| General Settings,| Dimming and Intensities Settings |

Initial Dimming and Intensity Levels
Dirnming Level X Intensity = Brightness
LEDO LED channel 0: 4095 100 |% x 2048 |50 % = | 2048 50 %
LED1 LED channel 1: | 4095 | | 100 % X 2048 | 50 % = 2048 50 o,
LEDZ—]» LED channel2: (4095 (100 (% x 0 |00 (% = |0 00 |%

> Rename the PDM_BCCU instance label according to the table below

- Right-click PDM_BCCU APP
— Select "Rename Instance Label”

LEDO R_LED1
LED1 G_LED1
LED2 B_LED1

Repeat the above steps with the other 2 PDM_BCCU APP instances

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (ﬁﬁneon,
RGB lamp using LED_LAMP APP (11/20)

4. Assign PDM_BCCU APPs to the right channels (continued)
» Click # to assign pins to PDM_BCCU APPs

» Assign pins as shown:

i Manual Pin Allocator I,&J
Filter ALL -
E &

APP Instance Mame  APP Pin Mame Pin Mumber (Port)
4 B LED1

PDM Output pin #1E(PO1) -
4 G_LEDM

PDM Output pin #30 (P011) -
4 F_LED1

POM Cutput pin =21 (P04 =
'/?3' Save | | Reset | | Llose

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (iﬁﬁneon,
RGB lamp using LED_LAMP APP (12/20)

5 ] Configu re BCCU gIObaI am LPP Dependency 57 | 4 HW Signal Connectivity

settings | e |
-0 — W
) D O u b I e = C I i C k 7 ‘ Izl_::'lf'.’l__EEuCuéIU_U ‘ E:IF."I__EEUCU(;JU_U

GLOBAL_BCCU_O in APP e
Dependency tab | |

GLOBAL_BCCU_0

'._Ill'
CLOCK_XMCA
CLOCK_XMC1_0D

GLOBAL BCCU 0 =2

Clock Settings | Functional Settings | Event Settings

» Under Clock Settings tab, st Clock (FCLK

. . Desired frequency [MHz]: 08 <(—
- to get a bit time of 5 us -

Actual frequency [MHz]: 0.8
— change the Desired Fast Prescaler factor (FCLK_PS) [hex: | 0:50
Clock Frequency to 0.8 S ok 6O
MHZz Mode: Normal Mode (BCLK = FCLK/4) =
Actual frequency [MHz]: 0.2
Actual time [us]: 5

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (iﬁﬁneon,
RGB lamp using LED_LAMP APP (13/20)

5. Configure BCCU global settings (continued)
> Under Functional Settings tab,

- limit the maximum possible off time to approx. 5ms (no flicker)
- change ON-bit insertion threshold to 1024

GLOBAL_BCCUO 2
Clock Settings | Functional Settings | Event Settings
Initial global dimmming level [dec]: 0

Trigger / Trap Configuration
Trigger mode selection: | Mode 0: Trigger On Any Channel -

Trigger delay selection: | BCCU Trigger On Channel Trigger -

Trap edge selection: Rising Edge -

Flicker Watchdog Settings

OM-bit insertion thresheld [dec): 1024 <(e—
Minirmum brightness [2]: 01
Longest OFF-tirme at modulator cutput [us]: 5115

Lowest frequency at modulator cutput [Hz]: 19531



Getting started — Example 1 (ﬁ{ﬁneon
RGB lamp using LED_LAMP APP (14/20)

6. Configure PORT Pins [ o are =

Show hidden categories Search filter

» The intention of this step is to
ensure that the unused pins L periher) Confgurten :
(to the LED2 and LED3) are " e Aaoc o

aa CLOCK_XMCI [4.0.6]

not left in a floating state s CMSS D9 1402

sa CMSIS_ RTOS_RTX [4.0.2]
aa CPU_CTRL_XMCI [4.0.2]
wa DIGITAL 10 [4.0.6]

wa EVENT_DETECTOR [4.0.2]
am EVENT_GEMERATOR [4.1.8]

» Add 6 instances of s
DIGITAL_IO APP to the et

project - -

Double-Click on the APP to add it to the active project.

3| (D)

| Show latest versions only

Hide beta versions

The DIGITAL_IO APP is used to configure
a port pin as digital Input/Output.

@ APPInfo ||  Add || Close

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (iﬁﬁneon,
RGB lamp using LED_LAMP APP (15/20)

6. Configure PORT Pins (continued)

> Double-click a DIGITAL_IO APP to open Ul
» Set Pin Direction to Input/Output

DIGITAL IO 0 53
General Settings

Pin direction: | Input/Cutput - _
Input Settings
Tristate

Standard

Output Settings
Mode: Push Pull -

Initial output level: | Low -

> Repeat for other 5 instances of DIGITAL_IO APP



Getting started — Example 1 (ﬁ{ﬁneon,
RGB lamp using LED_LAMP APP (16/20)

6. Configure PORT Pins (continued)

» Click 4% to assign pins to DIGITAL_IO APPs

» Assign pins as shown:

4 DIGITAL IO 0

pin £22(P05) -
4 DIGITAL IO 1

pin #23 (P06) -
4 DIGITAL_IO_2

pin £24 (P0O.T) -
4 DIGITAL IO 3

pin 227 (P0OS) -
4 DIGITAL_IO 4

pin #28 (P09) -
4 DIGITAL IO 5

pin £29 (P0.10) -

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (iﬁﬁneon,
RGB lamp using LED_LAMP APP (17/20)

7. Configure SysTick e

aaaaaaaaaaaaaaaaaaaa

» Add SYSTIMER to the project

ElE]

»

s 5
Fa fu

» Double-click SYSTIMER APP

to open Ul

- Set SysTick timer period e

to 1000 us

— Set Number of software
timersto 1l

SYSTIMER. O 532

General Settings | Interrupt Settings

) C“Ck E. to generate COde SysTick timer period [us]: 1000

Mumber of software timers: 1



Getting started — Example 1 (in’f?neon,
RGB lamp using LED_LAMP APP (18/20)

8. Define SYSTIMER callback function

> Purpose of callback function is to change the colour and
brightness of LED every 7 seconds

y Initialize callback function

void OneSecTick(void);

»y Create software timer and start timer

uint32_t timer_id;
TimerId = SYSTIMER CreateTimer (1000000,SYSTIMER MODE PERIODIC,OneSecTick,NULL);

SYSTIMER _StartTimer(TimerId);



Getting started — Example 1 (ﬁﬁneon,
RGB lamp using LED_LAMP APP (19/20)

8. Define SYSTIMER callback function (continued)

void OneSecTick(void) else if (step==33) {// dim down slowly to 0%

{ . . RGB_LAMP_config.dim_level = 0;
static uint8_t step = 0; LED_LAMP_SetDimLevelExponentialAdv(&RGB_LAMP,@x64,0xDB);
if (++step==1) {// change color to red }

RGB_LAMP_config.led_intensity[@] = 4695
RGB_LAMP_config.led intensity[1l] =
RGB_LAMP_conflg led_intensity[2] = 6

else if (step==40) {// dim up slowly to 25%
RGB_LAMP_config.dim_level = 1024;

LED_LAMP_SetColorAdv(&RGB_LAMP, gszc); LED_LAMP_SetDimLevelExponentialAdv(&RGB_LAMP,0x64,0xDB);
- - }
else if (step==9) {// change color to green else if (step==47) {
RGB_LAMP_config.led_intensity[@] = ©; step = 0;
RGB_LAMP_config.led intensity[1] = 4095; }
RGB_LAMP_config.led_intensity[2] = ©; }

LED_LAMP_SetColorAdv(&RGB_LAMP, 9X2AC),

}
else if (step==17) {// change color to blue

RGB_LAMP_config.led_intensity[@] = ©;
RGB_LAMP_config.led intensity[1l] = ©;
RGB_LAMP_config.led_intensity[2] = 4095;

LED_LAMP_SetColorAdv(&RGB_LAMP, ©x2AC);

else if (step==25) {// change color to white

RGB_LAMP_config.led_intensity[@] = 1365;
RGB_LAMP_config.led intensity[1] = 1365;
RGB_LAMP_config.led_intensity[2] = 1365;

LED_LAMP_SetColorAdv(&RGB_LAMP, ©x2AC);

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 1 (ﬁf’i’neon
RGB lamp using LED_LAMP APP (20/20)

)] Bu | Id prOJeCt om APP Dependency o4 HW Signal Connectivity & Console 52 [ Properties |®
CDT Build Conscle [RGELamp_Exarnplell]
H '"Finished building: RGBELamp_Example®l.lst’
1. Click E%
"Invoking: ARM-GCC Print Size’
: : o "C:\DAVEv4\DAVE-4.1.2\eclipse \ARM-GCC-49/bin/arm-none-eabi-size”
2 . Wa It fo r Bu I Id to fl n ISh text data bss dec hex filename
6184 443 1168 7652 1de4 RGELamp Example@l.elf
) Download COde 'Finished building: RGBLamp_Example@l.siz'
H 15:87:38 Build Finished (tock 31s5.558ms)
1. Click 3=

2. Switch to Debug view
T DAVEIDE 4 DAVECE |45 Debug |

3. Click #» to run code

> LED1 regularly changes color
and brightness

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 2 (iﬁﬂwon
White lamp using LED_LAMP APP (1/19)

Example 2: White Lamp using LED_LAMP APP

Connect to PC

XMC1200/XMC1300

White LED Card

CPU Card

N p24 00 p28 @ p22 00 P23
p2.6 OO P27 p2.6 OO0 p24
p2.8 OO p2.9 pa.14 OO0 poas @
p2.4e O O p2.11 pe.12 OO0 pPo.a3

p;., amb88 OO voD Ppe.ae OO pe.i

20 b iy

(Infineon
£ U

e, inLight ¢
8 uhite LED

:l‘fm.s 00 Ip1l4 pa.g 10O pa.g

ffrs = [f1-3° 0O P2 ugsp O O!|upboP
; fa 'Ei.l OO pilp pa.s OO po.7
N\ Pe.e OO po.d pe.4 OO pa.s

. ’_96,2 0.0 n.c.

L wuuiinfineon.co 2

24V Power Supply
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Getting started — Example 2 (ﬁ,’ffneon
White lamp using LED_LAMP APP (2/19)

3. Select the device accordingly
[ |

1. Open DAVE™

% New DAVE Project

Microcontroller Selection Page

Select the microcontroller for which the project has to be created

2. In DAVE™ workspace, create a :

» [ XMC4000

new “DAVE™ CE” project: cEey
a AMC1200 Series

. . AKMC1200-T0O38:0200

,  File->New->DAVE™ Project il .
[] XMC1202-Q040:0016
[] XMC1202-T028x0064

[T] XMC1202-T028x0032
[ XMC1202-T028:0016

» Give the project a name e.q. " arcion-chsnicn g

Microcontroller Features

m,

“WHITE_LAMP_EXAMPLE"
— i Package= TSSOP33 -
ROM= 200 KB Flash E
% New DAVE Project 1 S| RAM= 16 KB RAM
InQut= 34 digital /'O

A\
) S e | e Ct DAV ETM C E DAVE Project ADC=12 ADC Channels, 12-bit, Analog-to-Digital Converter i

Create a new C/C++ project for Infineon tool chains

3 n - . .
P ro] e Ct a S P rOJ e Ct Project Name:  Streetlamp_Exampledl _ Lt e .
Remove unused sections

Use default location . .
Runtime Library

I y pe C:/Workspaces/DAVE-4.1.2/XMC_LED_Current_Control_Explorer W/ | Browse
Library Mewlib-nano -
Project Type: Tool Chain:
4 (= Infineon Projects ERM IS n T [ Add floating point suppert for printf

4 [ ARM-GCC Application
[ Easy Start Project
[ Simple Main Project
[2] DAVE CE Project
[ Empty Project

4 (= ARM-GCC Library
[ Empty Project

[] Add floating peint support for scanf

‘/?3' Next > Finish ] I Cancel

Show project types and tol chains anly if they are supported on the platform

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 2 (in’f?neon,
White lamp using LED_LAMP APP (3/19)

»  This example demonstrates White Lamp functionality using
LED_LAMP APP

»  We will use the System Timer (SysTick) as the time base for the
interrupt

— Time base of 1 s

— In the interrupt, a new taﬁget dimming level is set and the
dimming process is starte

> Next, we will show you the steps to creating this project:

Instantiate LED_LAMP APP

Configure LED_LAMP APP

Assign PDM_BCCU APPs to the right channels
Configure BCCU Channels

Configure Brightness and Color Control Unit (BCCU) global
settings

Configure SysTick
7. Define the SYSTIMER callback function

nihwhe=

o



Getting started — Example - (iﬁﬁneon,
White lamp using LED_LAMP APP (4/19)

1. Instantiate LED_LAMP APP i

»  Click *, to add new APP

Bl

» Select the LED_LAMP APP

»  LED_LAMP APP automatically
aggregates a BCCU channel app oo
(PDM_BCCU), a BCCU dimming
engine app (DIM_BCCU) and a 7
BCCU global app ® ) ]

(GLOBAL_BCCU) |

am APP Dependency i35 | g HW Signal Connectivity

LED_LAMP

LED_LAMP_0
|
W “
PDM_BCCU DIM_BCCU
PDM_BCCU_0 DIM_BCCU_0

T
=
GLOBAL_BCCU
GLOBAL_BCCU_0
T

CLOCK_XMC1 ‘

CLOCK_XMC1_0

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 2 (ﬁ{ﬁneon
White lamp using LED_LAMP APP (5/19)

2. Configure LED_LAMP APP 4 APP Dependency 52 | ua HW Signal Connectivity

LED LAKP
» Double-click LED_LAMP_O to —
Open UI T F-‘:I‘_E;CCLI - .- :II‘_EEICLI
-‘ PDM_BCCU_0 ‘ DIM_BCCU_0 ‘

GLOBAL_BCCU
GLOBAL_BCCU_0

T
— set Number of LED ‘ CLOCK_XMC1 ‘

CLOCK_XMC1_0
channels to 4

» Under General Settings tab,

- select Dimming Engine as (55 LED_LAMP 0 53
Dimming SOU rce General Settings | Dirmming and Intensities Settings
Settings

+|Enable LED_LAMP at initialization

LED driver
control method: | Direct PDM (External LED Drivers) -

Mumber of LED |4 <(u— il

channels;

Dimming source:| Dimming Engine -

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 2
White lamp using LED_LAMP APP (6/19)

2. Configure LED_LAMP APP
(continued)

> Under Dimming and B Lo =

General Settings | Dimming and Intensities Settings

I nte n Siti es Setti n g s ta b Initial Dimming and Intensity Levels

Dimming Level X Intensity

- setinitial Dimming Level @ = [° e

to 0 LEDchanneI?_; 0 X 4085 | L

— set initial Channel 1
Intensities to 4095 o |

- set initial Intensity linear (sl

walk time to 0 ms

- Set initial 0-100% p
= = o - Intensity linear walk time [ms]: rescaler
dimming transition time Y LNPRES:

to 0 s 0-100% dimming transition time [ms]: (p[;i?:clzlle:'rﬂl'

0

0xDE

(infineon.

Brightness

Divider 0l
(DIMDIV):



Getting started — Example 2 (ﬁf’i’neon
White lamp using LED_LAMP APP (7/19)

3. Assign PDM_BCCU APPs to the right channels

» Hover mouse cursor over the connecting arrow to a PDM_BCCU
APP

» A label will appear momentarily e.g. LEDO/LED1/LED2/LED3

o APP Dependency 52 | 44 HW Signal Connectivity & Console [ Properties [ Problems

LED_LAMP
LED_LAMP 0
- I\ @
|' -—--\.\I \
Y 1 b LEDCH b
POM_BCCU POM_BCCU POM_BCCU POM_BCCU DIM_BCCU
PDM_BCCU_3 PDM_BCCU 4 PDM_BCCU 2 PDM_BCCU 0 DIM_BCCU_0
— |

._1_1_-.1 L L
GLOBAL_BCCU
GLOBAL_BCCU_0

J
¥
‘ CLOCK_XMC1 ‘

CLOCK_XMC1_0
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Getting started — Example 2
White lamp using LED_LAMP APP (8/19)

3.

>

)

The labels correspond to the LED channels in the UI

Rename the PDM_BCCU instance label according to the table below

Assign PDM_BCCU APPs to the right channels (continued)

LED_LAMP O 52

General Settings | Dimming and Intensities Settings |

Initial Dimming and Intensity Levels

LEDQ —>| LED channel 0:
LED]— —> LED channel 1:

I—EDZ —>| LED channel 2
LED3 _— LED channel 3:

Right-click PDM_BCCU APP
Select "Rename Instance Labe

Dimming Level

0 0.0 %
%
%

or
o

X

X

X

X

X

Intensity

4085

4085

4085
4085

100

100

100

100

or
o

or
o

or
o

Brightness

or
o

or
o

or
o

(infineon

- New Label

LEDO
LED1
LED2
LED3

D_LED1
D_LED2
D_LED3
D_LED4

Repeat the above steps with the other 2 PDM_BCCU APP instances

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 2 (ﬁﬁneon,
White Lamp using LED_LAMP APP (9/19)

3. Assign PDM_BCCU APPs to the right channels (continued)
» Click # to assign pins to PDM_BCCU APPs

» Assign pins as shown:

i Manual Pin Allocator I,il?-,l
Filter ALL -
= =
APP Instance Mame APP Pin Mame Pin Mumber (Port)
a D LED
PDM Qutput pin #2 (P05 -
a D_LEDZ
PDM Qutput pin #23(P06) -
a D _LED3
PDM Qutput pin #24 (PO.T) -
a D_LED4
PDM Qutput pin #27 (P08 -
(?) Save | | Reset | | Cloze

Copyright © Infineon Technologies AG 2016. All rights reserved.



Getting started — Example 2 (ﬁﬁneon
White Lamp using LED_LAMP APP (10/19)

4 . CO n fi g u re BCC U C h a n n e I S wa APP Dependency 57 | aq HW Signal Connectivity & Console [[] Properties (2] Problems

» Double-click PDM_BCCU
instance D_LED1 ) (o] o) | =
» Select Flicker Watchdog
(WD) to enable —
» Select Packer to enable
» Set Number of ON-bits ecl: 00 Packer ON-bit counter: 0
grouped to 3 0 Packer OFF-bit counter value: 0
Number of ON-bits grouped: | 2
» Set Number of OFF-bits JTarget Number of OFF-bits grouped: | 50
rouped to 50 -
g P 4095 —

1
Flicker WD

I
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Getting started — Example 2 (ﬁﬁneon
White lamp using LED_LAMP APP (11/19)

4. Configure BCCU Channels

(continued) [ s |
) DOUbIe_CIiCk PDM—BCCU P|:|1_E!ccu||P|:n_Bﬁccu ‘ Pl:n_icu “ PI:I-]_E;&:CU ‘ |:||.1_e..c:cu ‘
instance D_LED2 | e ‘ _‘ eum” | | =
- e
» Select Flicker Watchdog
(WD) to enable I
» Select Packer to enable ' _
= WA Packer ON-bit counter: 0
) Set Packer OFF_bit Counter 0 Packer OFF-bit counter value:| 12
value tO 12 Number of ON-bits grouped: | 3
;';:"'lﬂs?:? Number of OFF-bits grouped: | 50
» Set Number of ON-bits poe
Gating
grouped to 3 = s
- Flicker WD
» Set Number of OFF-bits :.'

grouped to 50
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Getting started — Example 2 (ﬁﬁneon
White lamp using LED_LAMP APP (12/19)

4. Configure BCCU Channels

(continued) | o |
) DOUbIe_CIiCk PDM—BCCU PI:I-I_BCI'C.:-f:::-.-:}. Pl:n_;écLl PI:I-I_E‘;CU ‘ PEI-l_E;é lllll .1_5-.c..cu
instance D_LED3 ‘ D_LEDA: ‘ ‘ D_LEDE | ‘D:I;EDS\ /_“ D_LED|1 ‘ ‘ DDDDD _EJccu_u ‘
- em———
» Select Flicker Watchdog
(WD) to enable I
y Select Packer to enable —
clz| 0.0 Packer ON-bit counter: 0
» Set Packer OFF-bit counter ’ Packer OFF-bit counter value:| 25
value to 25 Number of ON-bits grouped: | 3
ir;l;:-:lgﬁ?;,r Number of OFF-bits grouped: | 50
» Set Number of ON-bits —
grouped to 3 Gating
_q - o
= Flicker WD
» Set Number of OFF-bits

grouped to 50
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Getting started — Example 2 (ﬁﬁneon
White lamp using LED_LAMP APP (13/19)

4. Configure BCCU Channels

(continued) [ |
) DOUbIe_CIiCk PDM_BCCU Pl:r-]_ec'éj::jl\\h‘.—mgécu ‘ PD|-1_§&CU “ PD'LE;&:CU ‘ D"-LE!E[;U ‘
instance D_LED4 B Cea ) P e ) [=5e,
» Select Flicker Watchdog s |
(WD) to enable =
» Select Packer to enable ;
c]: 0.0 Packer ON-bit counter: 0
) Set Packer OFF_bit Counter 0 Packer OFF-bit counter value:| 37
value to 37 Number of ON-bits grouped: | 2
ir;I;:-:lgs?:',r Number of OFF-bits grouped: | 50
» Set Number of ON-bits —
grouped to 3 = LT
- Flicker WD
» Set Number of OFF-bits S r:.
AND

grouped to 50
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Getting started — Example 2 (iﬁﬁneon,
White lamp using LED_LAMP APP (14/19)

5 . CO n fl g u re BCC U g IO ba I s APP Dependency 52 | 4g HW Signal Connectivity [E) Cansole [T] Properties 2 Problems

LED_LAMP

settings |
) DOU ble_CI iCk ‘ P:I'_Bci}i ‘ P I'_;;CL ‘ P:I'_-Ij;CLI ‘ P:l'_icu ‘ :||'_B£u
GLOBAL_BCCU_O in APP e e R
Dependency tab oo |
s
(] GLOBAL_BCCUD 52
) Under CIOCk Settings ta b, Clock Settings | Functicnal Settings | Event Settings
Fast Clock (FCLK)
—_ to get a bit time Of 4 us Desired frequency [MHz]: 1 —
Actual frequency [MHz]: 1
- Change the DeSired FaSt Prescaler factor (FCLE_PS) [hex]: | Oud0
Clock Frequency to 1 o
it Clock (BCLEK)
MHZ Mode: Mormal Mode (BCLK = FCLK/4) -
Actual frequency [MHz]: 025
Actual time [us]: 4 _
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Getting started — Example 2
White lamp using LED_LAMP APP (15/19)

5. Configure BCCU global settings (continued)
» Under Functional Settings tab,

— limit the minimum brightness to 1%
— change ON-bit insertion threshold to 100

GLOBAL_BCCUD &2
Clock Settings | Functional Settings | Event Settings
Initial global dimming level [dec]: 0

Trigger / Trap Configuration
Trigger mode selection: | Mode O: Trigger On Any Channel -

Trigger delay selection: | BCCU Trigger On Channel Trigger -

Trap edge selection: Rizsing Edge -

Flicker Watchdog Settings

OM-bit inzertion threshold [dec]: 100 _

Minirnum brightness [2&]: 1
Lengest OFF-time at modulator cutput [us]:

Lowest frequency at modulator cutput [Hz]: 2500

(infineon.



Getting started — Example 2

White lamp using LED_LAMP APP (16/19)

6. Configure SysTick

>

Add SYSTIMER to the project

Double-click SYSTIMER APP
to open Ul

- Set SysTick timer period
to 1000 us

— Set Number of software
timersto 1

Click :IE# to generate code

(infineon.

B [
%
aaaaaaaaaaaaaaaaaaaa
- =]
cccccccccccccccccc —
| 2] |
LOG IO [4.0.4]
CK_XMC1 [4.0.6]
SIS_DSP [4.0.2]
SIS_RTOS_RTX [4.0.2]
o CPU_CTRL_¥MC1 [40.2]
sn DIGITAL IO [4.06]
MNT_DETECTOR [4.0.2]
EMT_GENERATOR [4.1.8]
ERRUPT [4.0.4]
[414]
TIMER [4.1.6]
HDOG [4.06]
nnnnnnnnnnnnnnnnnnnnn
Hide beta versions
YSTIM he
eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee
given iod expi
@ )|

SYSTIMER. O 532

General Settings | Interrupt Settings

SysTick timer period [us]:

Mumber of software timers:

1000



Getting started — Example 2 (in’f?neon,
White lamp using LED_LAMP APP (17/19)

7. Define SYSTIMER callback function

» Purpose of callback function is to change the brightness of lamp
every 10 seconds

y Initialize callback function

void OneSecTick(void);

y Create software timer and start timer

uint32_t timer_id;
TimerId = SYSTIMER CreateTimer (1000000,SYSTIMER MODE PERIODIC,OneSecTick,NULL);

SYSTIMER _StartTimer(TimerId);



Getting started — Example 2

White lamp using LED_LAMP APP (18/19)

7. Define SYSTIMER callback function (continued)

void OneSecTick(void)

{

}

static uint8_t step = 0;

if (++step==1) {
/* Dim up to 10% slowly */
LED_LAMP_© config.dim_level = 410;
LED LAMP_SetDimLevelExponentialAdv(&LED LAMP @, ©x64, ©OxDB);
}
else if (step==10) {
/* Dim up to 100% slowly */
LED_LAMP_© config.dim_level = 4095;
LED_LAMP_SetDimLevelExponentialAdv(&LED_LAMP_©, ©x64, ©OxDB);
}
else if (step==20) {
/* Dim down to 0% slowly */
LED_LAMP_© config.dim_level = 0;
LED_LAMP_SetDimLevelExponentialAdv(&LED_LAMP_©, ©x64, ©OxDB);

}

else if (step==30) {
step = 0;

}

Copyright © Infineon Technologies AG 2016. All rights reserved.
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Getting started — Example 2 (ﬁf’ﬂ]eon
White lamp using LED_LAMP APP (19/19)

) Bu I Id prOJeCt uw APP Dependency g HW Signal Connectivity [ Conscle 2 [] Properties [:_ Probh
. CDT Build Console [Streetlarmp_Exampledl_XMC12]

1 . CIle E 17:15:45 **** Build of configuration Debug for project Streetlamp _Examp.

"WCONDAVEVANADAVE -4, 1. 2V vec lipse\VARM-GCC-490 bin vmake " " --output-sy

"Invoking: ARM-GCC Print Size'

2. Wait for BUiId to finiSh "Cr\DAVEW4\DAVE-4.1. 2\eclipse\ARM-GCC-49/bin/arm-none-eabi-size” --forr

text data bss dec hewx filename

5628 396 1184 7128 1bd8 Streetlamp_Exampledl XMC12.elf
) Download COde "Finished building: StreetlLamp_Example®l XMC12.siz'
1 . CIle ﬁ-‘ 17:18:43 Build Finished (took 2m:57s.387ms)

2. Switch to Debug view
[T DAVEIDE g DAVECE (4% Debug |

3. Click [» to run code
> LEDs regularly change brightness

Copyright © Infineon Technologies AG 2016. All rights reserved.
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General information (1/2)

> Where to buy kit:

- http://ehitex.com/starter-kits/for-xmc1000

— Order Number: KIT_XMC1lx AK_LED 001

» Infineon parts utilized on kit:

Infineon parts
XMC1200 Microcontroller
XMC4200 Microcontroller
5 V regulator

3V3 regulator
BCR421/SC74 LED Driver
BCR450 LED Driver
TDA7200 RF Receiver

Order number
XMC1200-T038F0200
XMC4200-Q48F256
IFX25001TFV50
IFX25001MEV33
BCR421UE6327HTSA1L
BCR450E6327HTSA1
TDA7200XUMA1

(infineon


http://ehitex.com/starter-kits/for-xmc1000
http://ehitex.com/starter-kits/for-xmc1000
http://ehitex.com/starter-kits/for-xmc1000
http://ehitex.com/starter-kits/for-xmc1000
http://ehitex.com/starter-kits/for-xmc1000

General information (2/2)

Kit documentation:

LED Lighting Application Kit

Video series: XMC1000 boot kit getting started

Introduction

DAVE™ (Version 4) - Project Management

Boot Mode Index Configuration via DAVE™ or MemTool

Example Projects Download

Copyright © Infineon Technologies AG 2016. All rights reserved.
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http://www.infineon.com/cms/en/product/evaluation-boards/KIT_XMC1X_AK_LED_001/evaluation-boards/KIT_XMC1X_AK_LED_001/productType.html?productType=db3a30443ba77cfd013baec9c7880ca9#ispnTab4
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_511733/XMC1000-Boot-Kit-Getting-Started-Introduction.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_879614/dave-version-4-project-management.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_510857/XMC1000-Boot-Kit-Getting-Started-Boot-Mode-Index-Configuration-via-DAVE-or-MemTool.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_879614/dave-version-4-project-management.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_879614/dave-version-4-project-management.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_879614/dave-version-4-project-management.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_879614/dave-version-4-project-management.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_879614/dave-version-4-project-management.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_510857/XMC1000-Boot-Kit-Getting-Started-Boot-Mode-Index-Configuration-via-DAVE-or-MemTool.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_510857/XMC1000-Boot-Kit-Getting-Started-Boot-Mode-Index-Configuration-via-DAVE-or-MemTool.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_510857/XMC1000-Boot-Kit-Getting-Started-Boot-Mode-Index-Configuration-via-DAVE-or-MemTool.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_510857/XMC1000-Boot-Kit-Getting-Started-Boot-Mode-Index-Configuration-via-DAVE-or-MemTool.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_510857/XMC1000-Boot-Kit-Getting-Started-Boot-Mode-Index-Configuration-via-DAVE-or-MemTool.html
http://2696.2871.m.edge-cdn.net/vsc_2871_2696_1_vid_511107/XMC1000-Boot-Kit-Getting-Started-Example-Projects-Download.html
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References (infineon
Where to find APP documentation? (1/2)

» Go to Help > Help Contents e D o Sk S Worp o

L M= T () Help Contents
- 4 Search
) Cl ICk DAVETM APPS Dynamic Help

| Key Assist...

) C“Ck APP_Name (e_g_ Tips and Tricks...

DAVYE™ Forum

LED_LAMP) b

Send Feedback Mail

app
PP Cheat Sheets...
[ - — - ==~
% Help - DAVE
Search: Scope: All topics
Cont &~ | 5~ B[] O e D %+l & 0

@ Workbench User Guide DAVE JAPPS A

@ Java development user guid
\ Flug-in Development Envirg
@ Cs+ Development User G Contents
"~ DAVE APPs

© DAVE™ User Manual
@ EGit Documentation
@ Xtend User Guide

@ Xtext Documentation

m

ACIM FREQ CTRL [4.0.5]
ACMP CONFIG [4.0.3]

ADC MEASUREMENT [4.1.6]
ADC QUEUE [4.0.8]

ADC SCAN [4.0.6]

ANALOG 10 [4.0.4] |
AUTOMATION [4.0.7]
BUCK VOLT CTRL [4.1.13]
CAN NODE [4.1.6]

CLOCK XMC1 [4.0.6] |

= =, al
[JI L Y, D'—”I] - T T WRATA TA 08T i
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References infineon
Where to find APP documentation? (2/2)

» Usage information can be
found under Usage section

.
5 LED_LAMP T — = o

= . & Q & &
° ﬁ A. Hda Locate  Back Stop Heﬁ‘:esh Home Fort Pri Qptions

Hide Locate Stop  Refresh  Home Font Print  QOptions

Contets | index | Search | F4 || I
Conterts | index | Search | Ft || LED_LAM P - ET;ZPEQE LED_LAMP |E

@ Main F‘age % License Tems and Cop Home ‘ B
@ Apps @ Abbreviations and Defir
Data Structures @ Overview
g Files I @ Archiecture Descrtior| || USAQE
Q APP Corfiguration Para
= | @ Enumerations
LED_LAMP Documentation @ Dsla srucures usage
@ Methods
= () Usage The below figures shows typical usage of LED_LAMP using GLOBAL_BCCU
[£] Usage
@ Release History
I"dex @ Data Structures
Q Files
License Terms and Copyright \ LED .f
Information i AN Driver Ed
Abbreviations and Definitions FLeEa
Overview | N
Architecture Description \
APP Configuration Parameters { i ) LD -’
: : Driver z
Enumerations ! river
GLOBAL_BOOU .
Data structures Dimming Level :
Usage :
' e
H ! LED -
Release History | . 2
PDM_BCOU :
«oom L E ks
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References (infineon
Where to download example projects?

» Two sets of example projects available

— Additional application examples
— Can be downloaded directly from the web
- DAVE™ project library examples

— Can be downloaded from library in DAVE™
— Can also be downloaded directly from the web



References (infineon
Where to download example projects?

» Additional application examples available

— RGB Lamps Example with Apps
(LED_LAMP_3RGB_EXAMPLE_XMC12.zip)

- Demonstrates 3 RGB Lamps functionality using 3 LED_LAMP APPs
(9 Channels, 3 Dimming Engines)

- RGB Lamp Example
(BCCU_RGB_LAMP_EXAMPLE.zip)

— Demonstrates 1 RGB Lamp functionality using XMC™ Lib



References (infineon
Where to download example projects?

» Additional application examples available

- White Lamp Example
(BCCU_WHITE_LAMP_EXAMPLE.zip)

- Demonstrates white lamp functionality using XMC™ Lib
» Can be downloaded from the web HERE


http://www.infineon.com/cms/en/product/evaluation-boards/KIT_XMC1X_AK_LED_001/evaluation-boards/KIT_XMC1X_AK_LED_001/productType.html?productType=db3a30443ba77cfd013baec9c7880ca9#ispnTab4

References (infineon
How to load example project in DAVE™? (1/5)

» Download example projects via DAVE™ library store
- Help - Install DAVE™ APP/Example/Device Library...
2XMC_LED_Current_Control_Explorer Workspace ]

DAVE Window | Help

L T = # (Z) Help Contents
Search

.-’)'
Dynamic Help

Key Assist...
Tips and Tricks...
DAVE™ Forum
DAVE™ MNews
:;E Send Feedback Mail
pp Cheat Sheets...

g2y Install DAVE APP/Example/Device Library...
Check for DAVE APP Updates
Uninstall DAVE APP/Example/Device Library...
"%g Check for Updates
gt Install New Software...
By Installation Details

- Debug ]

+ < | * About DAVE™
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References
How to load example project in DAVE™? (2/5)

(infineon

» Select DAVE™ Project Library Manager in the drop-down

menu

.
o Library Manager Wizard S-S |- ]

Download Libraries Page

This wizard page helps in downloading the libraries of type example projects or APPs library

Dave Site

Work with :| DAVE Project Library Manager

Libraries

Enter the keywords to filter :

Description

Filters

Hide items that are already downloaded

[] Show only latest version

o)
( ?/ )

Find more library by working with the Library Update Sites preferences

Version Path

< Back Mest > Einish

s

Cancel

Copyright © Infineon Technologies AG 2016. All rights reserved.



References

How to load example project in DAVE™? (3/5)

» Select examples in the Libraries window and click Next

.
& Library Manager Wizard S ]

Download Libraries Page

Dave Site

Libraries

MName

This wizard page helps in downloading the libraries of type example projects or APPs library

Work with : DAVE Project Library Manager

Enter the keywords to filter :

- [paac]

Find mare library by working with the Library Update Sites preferences

» [CXMC4000¢
4 [7] XMC1000

Version Path

> [] XMC1300 Series
a XMC1200 Series
> DAVE w4 Example Projects with DAVE APPs

> DAVE w4 Example Projects with XMC Lib
> [] XMC1100 Series

Description

Filters

[] Show only latest version

"
(‘3/.

Hide items that are already downloaded

< Back Next > s

Copyright © Infineon Technologies AG 2016. All rights reserved.
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References (infineon
How to load example project in DAVE™? (4/5)

» Accept terms of the license agreement and click Finish

The software you have requested for download is protected by »
naticnal and international copyright laws and may be protected by
other intellectual property rights.

You shall use the seftware only in accordance with the applicable
licensing terms and conditions which may be different from the
terms and conditions of the DAVE Software License Agreement. For
copyright information, licensing terms and additional information
(e.g. on how to obtain the source code of such Open Source
Software], please check the "Help Function”, Section "Copyright
and Licensing Information” of the software,

By downloading the software, you acknowledge that you have read
and understood this download notice,

@ 1 accept the terms of the license agreements

I do not accept the terms of the license agreements

< Back | Mext = [ Einish ] | Cancel

» DAVE™ example projects are installed

Copyright © Infineon Technologies AG 2016. All rights reserved.



References (infineon
How to load example project in DAVE™? (5/5)

» Download Example Projects from the web

http://www.infineon.com/dave/v4

DAVE™ XMC™ Lib (Low Level Driver for XMC™ MCUs) and DAVE™ APPs composed to application examples (1)
EXAMPLES =
s

— Download the project zip file and unzip to a known location

- Open DAVE™ and go to File > Import 2> Infineon >
DAVE™ Project

— Select Select Archive File

- Browse to the downloaded DAVE™ project zip file
— Click Open
— Click Finish

Copyright © Infineon Technologies AG 2016. All rights reserved.


http://http/www.infineon.com/dave/v4

Support material

Collaterals and
Brochures

Document

X

Videos

Contact Support
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http://www.infineon.com/XMC
http://www.infineon.com/XMC
http://www.infineon.com/cms/en/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-registered-cortex-registered-m/32-bit-xmc1000-industrial-microcontroller-arm-registered-cortex-registered-m0/xmc-development-tools-kits-and-boards/channel?channel=db3a30433d5e5530013d64397b0c2043
http://www.infineon.com/cms/en/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-registered-cortex-registered-m/32-bit-xmc1000-industrial-microcontroller-arm-registered-cortex-registered-m0/dave-version-4-free-development-platform-for-?channel=5546d46145f1f3a4014619e925171bcc
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http://www.infineon.com/mediacenter
http://www.infineon.com/cms/media/Applications/microcontrollers/XMC/Mediathek.html
http://www.infineon.com/cms/media/Applications/microcontrollers/XMC/Mediathek.html
http://www.infineonforums.com/
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Disclaimer

The information given in this training materials is given as a hint for
the implementation of the Infineon Technologies component only and
shall not be regarded as any description or warranty of a certain

functionality, condition or quality of the Infineon Technologies
component.

Infineon Technologies hereby disclaims any and all warranties and
liabilities of any kind (including without limitation warranties of non-
infringement of intellectual property rights of any third party) with
respect to any and all information given in this training material.
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